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Abstract
In this tutorial we will be looking at working with object 
information, and the analysis that you can undertake 
using the report system.

The tutorial has been written using the Fractional Feet 
& Inches Unit type.

For any queries during the tutorial, please use the 
MacDraft Professional documentation or contact our 
technical support from our website. You can also use 
the Forum on our website for reference. 

Tutorial Difficulty  (Shown on Front)
Microspot Tutorials are graded in a level of difficulty, 
where:

Beginners Tutorial - Requires no previ-
ous knowledge of the application.

Intermediate Tutorial - Requires some 
limited knowledge of the application.

Advanced Tutorial - Comfortable in 
using all aspects in the application.
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Accompanying Files:
There are some files available to you for this tutorial. 
Each of which can be located in the “~/Library/
Microspot/MacDraft Pro/Object Information & 
Reports” folder.

•	 House Plan

•	 House Elements library file



1.0 Object Information

In this chapter we will look at the key 
areas of object information. Giving 
an insight into the working practice 
when assigning criteria, and getting 
ready for analysis.
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1.1 Introduction

In Microspot MacDraft, you can associate names and other text information with objects or groups. This lesson 
covers how to assign object information to items in a drawing, then use that information to find and replace items, 
to present data about the items in a report. 

The drawing you will be using, called “House Plan” already has object information assigned to many of its objects. 
The following exercises will show you how to access, change, and use that object information.

First, let us open the drawing and look at some of the object information:

1.	 Launch MacDraft and open the House Plan drawing accompanying this tutorial.
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2.	 Select one of the plain stepping stones.

3.	 Click the first tab on the right panel to open the Properties pane, and locate the Name field and the Object 
Info fields that show the object information for the selected item.

Here, the object Name is “Stepping Stone” and its Type is “Smooth”.

The object information can be used as criteria for searches using the Find and Replace feature, or for functions in a 
MacDraft Report Format; you will learn about these later in the lesson. 

Each object or group can have up to five text strings assigned to it, in “fields.” The first field is always called “Name” 
and can be used to hold the object’s name. You can give the other four fields different type-names, depending on 
what information each field will hold. (Note that you don’t have to use all the fields when you assign object informa-
tion.)

An item retains its object information if you copy and paste it, duplicate it, or move it — even if you put it into a dif-
ferent MacDraft document or a library catalog.
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1.2 Adding Object Information

Now let us add some object information to an item—the brick facing on the front of the house: 

The house has an exterior brick facing; it shows up on the drawing as four red parallel line objects, including the one 
shown here.

You can use the object information feature to specify a facing type of “Brick,” so that you can use a report function 
later to show the total length of the brick facing on the house. 

To add the type “Brick” to the facing:

1.	 Select one of the facing pieces. 

2.	 On the right panel, open the Properties pane. Note that the Name field is located at the very top, while the 
other Object Info fields are a bit further down.
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3.	 Select the Type field and enter “Brick”. 

4.	 Press the Enter key or click any other field or the background of the drawing. 

5.	 Repeat the previous steps for each of the other facing pieces. 

1.3 Editing Data Field Names

Each object or group can have up to five text strings assigned to it, in “fields.” The first field is always called “Name” 
and may be used to hold the name of the object. You can give the other four fields different type-names, depending 
on the information each field will hold. The default names are simple numeric indicators (F2, F3, F4, and F5). In this 
drawing, one of the field names is “Type” and you have already changed the Type of some objects (the facing). You 
can assign other names to fields, to make them more meaningful to your particular drawing. At this point we are 
going to assign the field names “Finish” to the third field (so far called only F3), and “Manufacturer” to the fourth 
field (so far called only F4). 

The field names are assigned using the Edit Field Names command in the Data menu or the Edit Field Names button 
in the Object Info section of the Properties pane.
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Take a look at the field names:

1.	 Open the Data menu and choose Edit Field Names.
The Edit Field Names dialog appears. 

The field name can contain letters, numerals, and punctuation marks (including spaces).

2.	 Select the third field (F3) and enter “Finish”. 

3.	 Select the fourth field (F4) and enter “Manufacturer”. 

4.	 Click OK. 

Any object that you enter data for uses the field names defined for the drawing, including the field names 
“Finish” and “Manufacturer” that you just defined. 

1.4 Using Find & Replace

You may sometimes need to find certain objects or groups quickly in a large drawing. Scrolling through a drawing 
and examining all the items to find objects can be time-consuming and inaccurate; it is better to use MacDraft’s Find 
and Replace feature. You use the Find and Replace feature to find and select objects or groups that have names or 
other object information assigned to them, and you can even replace them with other objects. This feature is most 
useful for finding items that have been copied many times in a drawing.

You define the objects to be found by specifying all or some of an object’s information as search criteria. The quick-
est way to define search criteria is to use the “Use Mouse” button to enter all of an item’s object information in-
stantly, by clicking on the item; you can then deselect unwanted fields if necessary. You can also type the desired 
object information into the appropriate fields; keep in mind that any typing errors will affect the results of the search, 
and may cause the wrong objects to be found.
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In this exercise, you will use the Find and Replace feature to replace the single-plug electrical outlets in the house 
plan with duplex outlets.

To move to the Electrical layer:

1.	 On the right panel, click the second tab to open the Layers pane. 

2.	 The view of the drawing will change to the Electrical layer, showing the location of  wall outlets in the house.

The duplex outlet you will use to replace the existing single outlets is in the House Elements library. You need 
to place a duplex outlet from there into the House Plan drawing.

1.	 Click the gear icon at the bottom of the Library viewer, which is in the lower part of the right panel.

2.	 Choose Open Library from the pop-up menu.

	 The standard Open dialog appears.

3.	 Locate the House Elements library file in the Tutorial folder, select it, and click the Open button.

	 The House Elements library opens in the Library viewer.

4.	 Select the Outlet symbol. 
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5.	 Drag the Outlet symbol onto an empty area of the House Plan drawing. 

The duplex outlet appears on the drawing. 

6.	 Click the drawing to make it the active document.

Now you can use the Find and Replace feature to replace the single outlets with the duplex outlets.

To replace one outlet with another:

1.	 Choose Find/Replace from the Data menu. 

The Find/Replace dialog appears, with no information entered.

You specify an object to find by entering its information into the appropriate fields. You can do this by typing 
in the information, or by using the mouse to select an object and automatically enter the information. For 
this exercise, it is easier to use the mouse. 
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2.	 Click the Find: Use Mouse button. 

The Find/Replace dialog temporarily disappears, and the special selection cursor (?) appears on the drawing. 

3.	 Click one of the single outlets.

The Find/Replace dialog reappears, with all the object information for the outlet displayed in the Find fields, 
and the Name field checked.

Notice that the total number of outlets found is displayed at the lower left of the dialog. 
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Now we need to include the Type field as part of the find criteria. 

4.	 Click the Type checkbox. 

Defining the item for replacement works in the same way. 

5.	 Click the Replace With: Use Mouse button.

The Find/Replace dialog temporarily disappears, and the selection cursor appears again.

6.	 Click the duplex outlet you placed on the drawing. 

The Find/Replace dialog reappears, with all the outlet’s object information displayed in the Replace fields. 
(Because replacement selections must be unique, with no ambiguity, MacDraft always uses all object infor-
mation fields to define a replacement.)
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The next step is to replace some outlets.

7.	 Click the Find Next button.

One of the existing outlets is selected. 

8.	 Click the Replace button. 

The selected outlet is replaced with a copy of the duplex outlet. 

9.	 Click the Find Next button. 

Another outlet that matches the Find criteria is selected. You can replace it or click Find Next again to move 
to the next matching object. 
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10.	Click the Replace button. 

This outlet is replaced with another copy of the duplex outlet. 

11.	Repeat the last two steps until all the outlets have been replaced. 

12.	Close the dialog. 

13.	Delete the duplex outlet that you first placed on the drawing.

You can also replace every occurrence of a defined object in one action. For example, you may have noticed that one 
of the stepping stones outside the house has a pattern, showing that it has an aggregate finish (instead of smooth 
concrete). You can replace all the smooth stepping stones with aggregate.

To replace all the stepping stones at once:

1.	 Switch to the Walls layer, then open the View menu and choose Stone View. 

The Drawing window changes to show the aggregate stepping stone (patterned) next to several of the 
smooth (plain) stones.

2.	 Choose Find/Replace from the Data menu. 

The Find/Replace dialog appears. 

3.	 Click the Find: Use Mouse button. 

The Find/Replace dialog temporarily disappears, and the selection cursor appears on the drawing. 

4.	 Click one of the smooth stepping stones.
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5.	 Click the Type checkbox to define Smooth as one of the Find criteria. 

6.	 Click the Replace With: Use Mouse button. 

The Find/Replace dialog temporarily disappears, and the selection cursor appears on the drawing.

7.	 Click the aggregate stepping stone.

The Find/Replace dialog reappears.
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The Find/Replace dialog reappears. 

The next step is to replace the stepping stones. 

8.	 Click the Find Next button. 

9.	 Click the Replace All button.

All of the drawing’s smooth stepping stones are replaced with aggregate stepping stones.



2.0 Reports

In this chapter we will look at the use 
of the object information for statisti-
cal analysis with the reports system. 
Showing how to view and print your 
reports.
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2.1 Introduction

You may often want to extract information from your drawing in the form of a report; or you may need a report 
detailing the properties of objects in your drawing, such as perimeter, area, length, or other measurements. 

Reports can be very useful for such things as determining the cost of a project or counting items in a drawing. Just 
about any drawing can be made more meaningful using MacDraft’s report functions. 

Any change made to your drawing will be reflected in your reports. Once you create a report, you don’t have to 
remember if you’ve changed the length of a wall or added furniture or fixtures to a layout. MacDraft’s automatic 
updating of any data you’ve designated for a report can save you hours of work and prevent many mistakes. 

MacDraft reports can include data about any objects to which you’ve assigned object information. In the Report 
Formats dialog, you designate which items of object information you want included as criteria, which functions 
(Count, Height, Length, Width, X Dimension, Y Dimension, Area, Perimeter or Totals) you want performed on the 
item, label the items if necessary, then print or display the report results. 

In this exercise, you will create a report showing the drawing’s total number of electric outlets and stepping stones, 
as well as the total length of brick facing and the total areas of carpet and linoleum. The functions you will use for 
the report are Count, Length, and Area.
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2.2 Creating Reports

Most report actions, including creation of a new report, begin with the Report Formats dialog. The dialog displays 
the names of all of a drawing’s reports, and its buttons initiate creating, editing, renaming, and deleting reports, as 
well as loading reports in from other drawings. 

To create a report:

1.	 Open the Data Menu and choose Report Formats.

The Report Formats dialog appears.

2.	 Click the “plus” button. 

A new report with a default name appears in the Reports list.
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3.	 To change the report’s name, click it once to select it, and then click it again. 

4.	  Type “House Elements” and press Enter. 

The report’s name changes in the list. 

You can now edit the report, setting it up to display the data you want.

MacDraft’s report formats can display the individual or total lengths, widths, heights, areas, and perimeters of ob-
jects or sets of objects chosen by the object information you specify. The reports can also display the count, or total 
number, of objects that match your criteria.
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Report formats include three basic elements: Functions, such as COUNT; Criteria for the functions (for example, you 
can COUNT all objects with Name = “Outlet” and Type = “Duplex”); and Text for headings and notes.

When the report is printed, not all the parts appear on the paper.

You set up a report mainly by using the row pop-up menus. These let you quickly define whether a row will contain 
text, criteria, or a function. All you need to do is hold down the mouse button at the end of the row and make your 
choice. 

The default condition for rows is text; any row not marked otherwise in the leftmost column is a text row. You can 
enter text in the row’s cells just by clicking and typing. You can also choose Text from the row pop-up menu to 
define a text row. 

Criteria Row Text Cells

Function Row

Row Pop-ups

Results Column
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Choosing Criteria from the row pop-up menu makes that row a criteria bar. Each column in the criteria bar has a 
menu containing the list of object field names you can use for criteria. You can choose a field name for a column or 
leave it Undefined. 

Adding a function to your report is as easy as choosing it from the menu. Once you’ve done so, the name of the 
function will be displayed at the beginning of the row. To set the criteria for the function, you enter the desired 
Object Info into the column under the appropriate field name. 

You can either type an object’s information manually to establish criteria or select the appropriate object after click-
ing the “Obj. Info.” button in the Report Formats dialog. This allows you to choose a function like COUNT, then click 
on a sample of the object you want to count. Its object information will be inserted automatically into the appropri-
ate criteria fields. 

You can continue to define additional rows of functions using the same field names, or insert a new criteria bar to 
change the field names used in the functions that follow. (Each function row is controlled by the closest criteria bar 
above it.) Inserting criteria bars and adding functions below them allows you to create comprehensive reports that 
may extend over multiple pages if needed. 

You can set up the parts of a report in any order, but usually the most sensible way is to first define the criteria bar, 
then choose the functions for that criteria bar, and finally enter the object information for each function. 

For this first simple example, you will set up one criteria bar, one function row, and one kind of object information, 
then immediately see the function’s result in the Results column. This will give you a realistic overview of the steps 
involved in getting a useful outcome. After that, you can construct the rest of the report, adding more criteria bars 
and function rows, then adjusting the format and inserting a title at the top.

First, set up the criteria bar:

1.	 Open the Report Formats dialog, if necessary. 

2.	 Select the House Elements report in the Reports list. 
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This criteria bar will control which items are totaled up using the COUNT function in the report. The next step is to 
create the function rows.

•	 Open the row pop-up menu at the left end of the row below the criteria bar, then choose Count.

3.	 Open a row pop-up menu a couple of rows down from the top, and choose Criteria.

The row reads “CRITERIA” in the first column, showing that it is a criteria bar. All the cells in the bar read 
“Undefined”, except the last which reads “Results”.
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The row displays the function COUNT in the first column, showing that it is a function row. 

To define which object information fields act as criteria for this function: 

1.	 Move the cursor to the first cell in the criteria bar, then press the mouse button. 

The drawing’s field names will appear in a pop-up menu.

2.	 Choose “Name” and release the mouse button. 

The cell reads Name. 

3.	 Move the cursor to the second cell in the criteria bar, then press the mouse button. 

4.	 Choose “Type” and release the mouse button.

The cell reads Type. 

The last kind of information to include is the object information itself. You can specify objects either by typing the 
object information manually or by clicking on an example object in the drawing. Usually it’s easier and faster to click 
an example object.
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To define a function’s object information by pointing and clicking:

1.	 Click a cell in the CRITERIA column. The row that contains the cell becomes selected. Click the Obj. Info. but-
ton at the lower left of the dialog.

The Report Formats dialog temporarily disappears, the drawing window becomes active, and the cursor has 
a question mark (“? ”) attached to it.

2.	 Click one of the duplex outlet symbols.

The Report Formats dialog reappears, and the row you clicked displays “Outlet” and “Duplex” in the Name 
and Type columns respectively.

NOTE: The Obj. Info. button can be used to add object information for objects on any visible and ungrayed layer.  
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2.3 Running the Report

You have now defined what the report will do (count objects) and which items it will use (duplex outlets). This edition 
of MacDraft lets you see the results of the function immediately.

To see the report results:

1.	 In the Report Formats dialog, look along the Count function row you set up until you get to the Results 
column.

You can see the exact count of the duplex outlets in the drawing. (Depending on the size of your screen, 
you may need to use the scroll bars to see the whole report.) In a moment you will edit the report to include 
several more functions, revealing other kinds of information about other objects.

2.	 Click the Done button at the bottom-right corner of the Report Formats dialog. The dialog closes.

As you have seen from this simplified example, there are three essential steps to setting up a report: first, setting up 
the criteria in a criteria bar; second, choosing a function; and third, defining the object information to be used with 
the criteria and the function. These three elements are the core of any MacDraft report. 
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Continue by inserting the object information for the stepping stones:

3.	 Click the new COUNT cell, and then click the Obj. Info. button at the lower left of the dialog.

The Report Formats dialog temporarily disappears, the drawing window becomes active, and the selection 
cursor appears.

4.	 Switch to the Wall layer, then click one of the aggregate stepping stones.

The Report Formats dialog reappears, and the row you clicked displays “Stepping Stone” and “Aggregate” 
in the Name and Type columns respectively. (If “Stepping Stone” is cut off, don’t worry; you will get a chance 
to fix the layout later.)

As you may have noticed, there are several segments of brick facing in the house plan. If more than one object 
matches a function’s criteria, MacDraft will automatically provide a total, reflecting all the matching objects, as the 
result. The next part of the report will display the total length of the brick facing. It will consist of a single function 
row. Because the function will use the same criteria (Name and Type) as the function rows above, there is no need 
for a new criteria bar. You do need to create a new function row, however.

Now you can start adding to the report, making it more like the type of report you are likely to produce in your own 
work. MacDraft allows for using many different reports in one drawing, but usually it makes sense to combine sev-
eral functions in one report format. 

This report will include an additional Count function, with Name and Type as criteria. The best place to put the sec-
ond Count function is right below the first, because each criteria bar remains “in force” for all functions until another 
criteria bar is inserted below it.

To set up the next function:

1.	 Open the Report Formats dialog. Open the row pop-up menu at the left end of the row below the Count 
function row, and choose Count.

2.	 Open the row pop-up menu at the left end of the row below the Count function row, and choose Count. 
The row displays the function COUNT in the first column, showing that it is a function row (just like the row 
above).. 
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To set up a new function row with object information:

1.	 Open a row pop-up menu about two rows below the last Count row, then choose Length.

The row will display the function LENGTH in the first column.

The Report Formats dialog will reappear, and the Length row will display “Facing” and “Brick” under Name 
and Type.

The final part of the report will display the total areas of the rooms with carpet. In this house plan, several rooms have 
a floor covering of carpet (represented in the drawing by large polygons on the Floor Covering layer). We could use 
separate functions to find the area of each carpeted room by name. However, it’s probably more useful to set up a 
single function with a single criterion (“Finish = Carpet”) to provide the total area of carpeting, without specifying 
the rooms by name. 

Because the new function will only use the field Finish for a criterion, it will need a new criteria bar.

NOTE: If you need to add rows to the report, click the gear icon in the bottom-right corner of the Report 
Formats dialog and choose Insert Row. A row will be inserted above the row you selected.

NOTE: Even though this function will use the same criteria as the functions above, you can leave a blank 
row above it to make the layout easier to read.

This row will depend on the first and second fields (“Name” and “Type” in this drawing) for its criteria, and 
will display the total length of any facing of the Type “Brick”.

2.	 Click in the “Length” row, then click the Obj. Info. button at the lower left of the dialog.

The drawing window will become active, and the cursor will have a question mark attached.

3.	 Click any of the segments of brick wall facing.
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To create a new criteria bar:

1.	 Open a row pop-up menu about two rows below the Length row, then choose Criteria.

The row will read “CRITERIA” in the first column, showing that it is a criteria bar, with all its cells reading 
“Undefined”.

2.	 Open the row pop-up menu at the left end of the row below the criteria bar, then choose Area 

The row will display the function AREA in the first column, showing that it is a function row.

This row will depend for its criteria on the third field (“Finish”).

To define which object information field acts as the criterion for this row:

1.	 Move the cursor to the first cell in the criteria bar, then press the mouse button. 

The drawing’s field names will appear in a pop-up menu. 

2.	 Choose “Finish” and release the mouse button.

The cell will read “Finish”.

As mentioned earlier, you can specify objects either by entering the object information manually or by clicking on an 
example object in the drawing. It is easy to enter “Carpet” manually.
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To specify by keyboard entry:

1.	 Click in the first cell (under “Finish”) in the first Area function row. 

2.	 Using the keyboard, type “Carpet” into the cell.

This row is now been set up to display the total area of carpet in the drawing, regardless of room.

At this point, you can run the report, and print it if you have a printer available. Later, you will insert another row to 
accommodate another function, along with a title for the report.

2.4 Printing the Report

When all the criteria bars, text labels, function rows, and object information are in place, you’re ready to run the 
report by printing it. Before printing, you may want to take a look at your report in the Preview application so you 
can visualize how it will look on paper. If you notice something that’s incorrect, you can close the preview and edit 
the report, or edit the drawing and update the report, before printing it. 

To see a preview of the report:

1.	 Open the Report Formats dialog and select the House Elements report.

2.	 Choose Print from the File menu. The Print dialog appears. 
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Depending on the size of your screen, you may need to use the scroll bars to see the whole report.

Before printing the report on paper, though, let’s add a title and another function.

1.	 Click Cancel on the report preview to close it and go back to the MacDraft application. Make sure the Report 
Formats dialog is open.

You are now going to add a title to the report. 

2.	 Click in the middle cell of the top row. 

The text-insertion cursor will begin flashing. 

3.	 Type House Items 

Now the report will have a title when printed. Notice that entering text requires no special row-selection. 

Next, let’s add a new function row to calculate the total area of linoleum needed for the kitchen, bathrooms, and 
any other rooms with linoleum floors. We’ll put this new function above the existing carpet row, inserting a new 
row to make room.

To insert a row so that the report can include the total area of linoleum:

1.	 Click the word AREA in the Carpet row.

The row will be selected.

2.	 Click the gear icon in the bottom-right corner of the Report Formats dialog and choose Insert Row from the 
pop-up menu.

3.	 Choose Open PDF in Preview from the PDF pop-up menu in the bottom-left corner of the Print dialog. A PDF 
document with the report is created and displayed in the Preview application. Depending on the size of your 
screen, you may need to use the scroll bars to see the whole report. You can click Print to print it.
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3.	 Make the new row into an Area row. 

4.	 Set the second Criteria column to Manufacturer. Click Done to save the changes and close the Report For-
mats dialog.

5.	 Use the Layers (second) tab of the right panel to set the current layer to Floor Covering.

6.	 Choose Report Formats from the Data menu to open the Report Formats dialog again.

7.	 Click the leftmost cell in the new “Area” row (above the Carpet row), then click the Obj. Info. button. 

The drawing window will become active, and the cursor will have a question mark attached. 

8.	 Click the linoleum floored kitchen.

The Report Format window will reappear.

The new row will display “Linoleum” in the Finish column. This word may be too long for the cell, covered by the 
word “Acme” in the next column (representing the manufacturer of the linoleum).

You can widen columns in a report format to make room for more letters in a cell.

1.	 Move the cursor to the top of the column containing the truncated word. 

2.	 Move the cursor to the right-hand edge of the column and press the mouse button. 

A new row will appear above the selected row.
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The cursor will change to the column-adjustment cursor. 

3.	 Holding down the mouse button, move the cursor about a quarter-inch to the right, then release the mouse 
button. 

The column will be wider, and its entire content should now be visible. If you want, you can adjust the widths of 
other columns as well to make the report look better.

Now you can create a new preview that includes the new function and the title.

1.	 In the Report Formats dialog, select the House Elements report, and then choose Print from the File menu. 

The Print dialog will appear. 

2.	 Choose Open PDF in Preview from the PDF pop-up menu in the bottom-left corner of the Print dialog. A new 
PDF document will be generated for the report, showing the report title and the area of all the linoleum in 
the drawing.

If you want to have a copy of the report on paper:

1.	 Click the Print button. 

The Print dialog for your active printer will appear. 

2.	 Make any selections you want in the Print dialog, and then click Print. 

The report will be printed.
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